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PMAC Controller SIO

Introduction
This manual describes how to connect the Display and the External Device (target PLC).

In this manual, the connection procedure will be described by following the below sections:

1 System Configuration
This section shows the types of External
Devices which can be connected and SIO

type.

& System Configuration” (page 3)

2 Selection of External Device

Select a model (series) of the External
Device to be connected and connection
method.

&~ "2 Selection of External Device" (page 7)

3 || Example of Communication Settings -
This section shows setting examples for "3 Example of Communication Setting” (page

communicating between the Display and 8)

the External Device.

4 Setup Items -
This section describes communication "4 Setup ltems” (page 11)
setup items on the Display.

Set communication settings of the Display
with GP-Pro EX or in offline mode.

5 Cable Diagram

This section shows cables and adapters
for connecting the Display and the
External Device.

&~ "5 Cable Diagram” (page 16)

Operation
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PMAC Controller SIO

1 System Configuration

The system configuration in the case when the External Device of Delta-TAU data system, inc. and the Display are

connected is shown.

Series CPU Link I/F SIO Type | Setting Example Cable Diagram
PC/104 . I w | . "
PMAC PMAC-Lite (S:e;gll Port on RS-232C (S;ttmég) Example 1 (Caablel 6D)lagram 1
PMAC-PC page page
Turbo PMAC1
Turbo PMAC2
Turbo Clipper
QMAC Serial Port on RS-232C "Setting Example 1" | "Cable Diagram 1"
Geo Brick Controller | CPU (page 8) (page 16)
Turb Geo PMAC Driver
P‘;/'l A°C PC/104 Turbo
Turbo PMAC PCI
Serial Port on "Setting Example 1" | "Cable Diagram 1"
CPU RS-232€ (page 8) (page 16)
UMAC
Aux Port on "Setting Example 1" | "Cable Diagram 1"
cpU"! RS-232€ (page 8) (page 16)

*1  This port can be used for general communications. It is possible to turn off the command parser for this
port by setting variable 143 to 1, so Turbo PMAC does not try to interpret incoming characters as
commands, making it possible for the user to parse incoming data as he pleases.

B Connection Configuration

1:1 connection
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m |[PC COM Port

PMAC Controller SIO

When connecting IPC with an External Device, the COM port used depends on the series and SIO type. Please

refer to the IPC manual for details.

Usable port
Usable Port
Series
RS-232C RS-422/485(4 wire) | RS-422/485(2 wire)

coM1™!', comz,
PS-2000B cOM3*L COM4 - -
PS-3450A, PS-3451A, 10 . 1
PS3000-BA, PS3001-8p | COMI, COM2 COM2 CoM2
PS-3650A (T41 model), -
PS-3651A (T41 model) CoMI ) )
PS-3650A (T42 model), *1%) *1%) *]%)
PS-3631A (T42 model) coM1™1"2, com2 COMI COMI
PS-3700A (Pentium®4-M) | COM1*!, cOM2™!, o o
PS-3710A COM3™2 , COM4 COM3 COM3
PS-3711A coM1™!, com2™ com2™ coMm2™
PS4000"3 COM1, COM2 - -

coM1*"2, com2™, 1% 1%
PL3000 COMS3, COM4 COMI COMI
PE-4000B Atom N270 COM1, COM2 - -

COM3™ , COM4™, | cCOM3™, coM4™,

PE-4000B Atom N2600 COMI, COM2 CoMs™ come™ | CoMs™ COME™
PS5000 (Slim Panel Type 4 4 4
Core i3 Model) *> *6 COM1, COM2 COM2 COM2
PS5000 (Slim Panel Type
Atom Model) coM1, com2™7 com2™7 com2™?
*5 %6
PSSOQ% (Enclosed Panel COMI ) )
Type)
PS5000 (Modular Type
PFXPU/PFXPP)"> *6 7 7 o
PS5000 (Modular Type CoMI coMl CoMl
PFXPL2B5-6)
PS5000 (Modular Type *7 *7 *7
PFXPL2BI-4) COM1, COM2 COM2 COM2
PS6000 (Advanced Box) 9 *10 #10
PS6000 (Standard Box) COM1
PS6000 (Basic Box) coM1™ com1™ com1™

*1  The RI/5V can be switched. Use the IPC’s switch to change if necessary.

*2  Set up the SIO type with the DIP Switch. Please set up as follows according to SIO type to be used.
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PMAC Controller SIO

*3  When making communication between an External Device and COM port on the Expansion slot,
only RS-232C is supported. However, ER (DTR/CTS) control cannot be executed because of the
specification of COM port.

For connection with External Device, use user-created cables and disable Pin Nos. 1, 4, 6 and 9.
Please refer to the IPC manual for details of pin layout.

*4  Set up the SIO type with the BIOS. Please refer to the IPC manual for details of BIOS.

*5  When setting up communication between an External Device and the RS-232C/422/485 interface
module, use the IPC (RS-232C) or PS5000 (RS-422/485) cable diagrams. However, when using
PFXZPBMPR42P2 in a RS-422/485 (4-wire) configuration with no flow control, connect 7.RTS+
and 8.CTS+, and connect 6.RTS- and 9.CTS-.

When using RS-422/485 communication with External Devices, you may need to reduce the
transmission speed and increase the TX Wait time.

*6  To use RS-422/485 communication on the RS-232C/422/485 interface module, the DIP Switch
setting is required. Please refer to "Knowledge Base" (FAQs) on the support site. (http://www.pro-
face.com/trans/en/manual/1001.html)

Settings FAQ ID
PFXZPBMPR42P2, RS422/485 change method FA263858
PFXZPBMPR42P2 termination resistor setting FA263974
PFXZPBMPR44P2, RS422/485 change method FA264087
PFXZPBMPRA44P2 termination resistor setting FA264088

*7  Set up the SIO type with the DIP Switch. Please refer to the IPC manual for details of DIP Switch.
The BOX Atom has not a switch to set the RS-232C, RS-422/485 mode. Use the BIOS for the
setting.

*8  For the connection with the External Device, on the user-created cable read as if the connector on
the Display-side is a M12 A-coding 8 pin socket. The pin assignment is the same as described in
the cable diagram. For the M12 A-coding connector, use PEXZPSCNM122.

*9  In addition to COM1, you can also use the COM port on the optional interface.

*10 Install the optional interface in the expansion slot.

DIP Switch settings (PL3000 / PS3000 Series)

RS-232C
DIP Switch Setting Description
1 OFF"! Reserved (always OFF)
2 OFF
SIO type: RS-232C
3 OFF
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220Q2) insertion to SD (TXD): None
6 OFF Terminal resistance (220Q2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF
RS (RTS) Auto control mode: Disabled
10 OFF

*1  When using PS-3450A, PS-3451A, PS3000-BA and PS3001-BD, turn ON the set value.
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RS-422/485 (4 wire)

DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220€2) insertion to SD (TXD): None
6 OFF Terminal resistance (220€2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF
RS (RTS) Auto control mode: Disabled
10 OFF
RS-422/485 (2 wire)
DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220Q2) insertion to SD (TXD): None
6 OFF Terminal resistance (220€2) insertion to RD (RXD): None
7 ON Short-circuit of SDA (TXA) and RDA (RXA): Available
8 ON Short-circuit of SDB (TXB) and RDB (RXB): Available
9 ON
RS (RTS) Auto control mode: Enabled
10 ON

GP-Pro EX Device/PLC Connection Manual 6
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Selection of External Device

Select the External Device to be connected to the Display.

B Welcome to GP-Pro EX E
— Device/PLC
Mumber of Devices/PLC: |1 3: .
Device/PLC 1
Manufacturer | Delta-TAL data system, inc. |L
Series PMAL Contraller 510 [+
Fart COM1 [+
Eefer to the manual of this Device/PLC
Eecent Device/PLC
4 L
I Use Spstem Area Drevice Information

Back [B] | Communication Settings | Mew Logic | Mew Screen I Cancel

Setup Items

Setup Description

Number of Devices/
PLCs

Use an integer from 1 to 4 to enter the number of Devices/PLCs to connect to the display.

Manufacturer

Select the manufacturer of the External Device to be connected. Select "Delta-TAU data
system, inc.".

Series

Select the model (series) of the External Device to be connected and connection method.
Select "PMAC Controller SIO".

Check the External Device that you can connect in "PMAC Controller SIO" in system
configuration.

& System Configuration" (page 3)

Port

Select the Display port to be connected to the External Device.

Use System Area

Check this option when you synchronize the system data area of Display and the device
(memory) of External Device. When synchronized, you can use the ladder program of
External Device to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "Display Unit (System Area) Settings Guide"

Cf. Maintenance/Troubleshooting Manual "Main Unit - System Area Settings"

GP-Pro EX Device/PLC Connection Manual
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PMAC Controller SIO

3 Example of Communication Setting

The following shows examples of communication settings of the Display and the External Device, which is

recommended by Pro-face.

3.1 Setting Example 1

W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
M anufacturer |Delta-TAU data system, inc. Series P& Contraller SI10 Port  |COR1
Text Data Mode ’T Change
Communication Settings
SI0 Type + RS232C " RS422/485(2wire) " RS422/485(4wire)
Speed 38400 =
Data Length 7 (O]
Parity (+ NOME " EVEM " ooD
Stop Bit 1 2
Flow Contral (+ NOME " ER[DTR/CTS) " XON/HOFF
Timeout 3 3: [zec)
Fietry 2 3:
‘Wait To Send 1] 3: [mz]
Rl /WCC + Rl " WCC
I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's R5232C
Isolation Unit, please select it to WCC. Diefault
Device-Specific Settings
Alloweable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo. Device Mame Settings Device
1 [PLcT [ [Mirirmum Frame=0FF mas word Block Fiead=64

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]

window, select the external device and click [Settings] Ff: .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

[ Minimum Frame

ok |

Cancel |

NOTE e If Minimum Frame is checked, Device Address Parts on communication Frame becomes a

minimum length.

GP-Pro EX Device/PLC Connection Manual 8
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B Settings of External Device
Use the Delta-TAU System PMAC Executive Pro Suite (Pewin32 Pro) to configure communication settings for
the External Device.

Refer to your External Device manual for details.

1 Start up PMAC Executive Pro Suite (Pewin32 Pro).

2 From the [Setup] menu, select [Force All Windows to Device Number].

3 Inthe [PMAC Devices] dialog box, click [Insert] to insert a communication port.

4 1In the [Available PMAC Devices] dialog box, click [New] to create a PMAC device .

5 Inthe [Configure Ethernet Devices] dialog box, select [PmacETHO] and define the IP address of the PMAC
controller.

6 Select the PMAC ETHO port and click [OK].

7 From the [View] menu, select [Terminal].

8 1n the Terminal dialog box, define the Setup Items (153, 154, 13, 14, 16)

Setup Items Type Value

Baud Rate 153=12, 154=12"!

Data Length -
Stop Bit -

Parity -

Flow Control -

1/0 handshake Control 13=2

Communication Integrity Mode 14=2

Error Reporting Mode I6=1

*1  Serial Port is 154, Auxiliary Serial Port is I53. Please refer to
“Auxiliary Serial Port Baud Rate Control” below.

9 To save your changes in the Terminal dialog box, use the “SAVE” command. To reset, use the “$$$” command.

Auxiliary Serial Port Baud Rate Control

« I53
Setting Value Baud rate Setting Value Baud rate

0 Disabled 8 9600

1 600 9 14400

2 1200 10 19200

3 1800 11 28800

4 2400 12 38400

5 3600 13 57600

6 4800 14 76800

7 7200 15 115200

GP-Pro EX Device/PLC Connection Manual 9
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o 154
Setting Value Baud rate Setting Value Baud rate

0 600 8 9600

1 900 9 14400
2 1200 10 19200
3 1800 11 28800
4 2400 12 38400
5 3600 13 57600
6 4800 14 76800
7 7200 15 115200

GP-Pro EX Device/PLC Connection Manual 10
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Setup Items

Set communication settings of the Display with GP-Pro EX or in offline mode of the Display.
The setting of each parameter must be identical to that of External Device.

&3 Example of Communication Setting" (page 8)

4.1 Setup Iltems in GP-Pro EX
B Communication Settings
To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
Device/PLC 1 |
Summary Change Device/PLC
M anufacturer |Delta-TAU data system, inc. Series P& Contraller SI10 Port  |COR1
Text Data Mode ’T Change
Communication Settings
SI0 Type + RS232C " RS422/485(2wire) " RS422/485(4wire)
Speed 38400 =
Data Length 7 (O]
Parity (+ NOME " EVEM " ooD
Stop Bit 1 2
Flow Contral (+ NOME " ER[DTR/CTS) " XON/HOFF
Timeout 3 3: [zec)
Fietry 2 3:
‘Wait To Send 1] 3: [mz]
Rl /WCC + Rl " WCC
I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's R5232C
Isolation Unit, please select it to WCC. Diefault
Device-Specific Settings
Alloweable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo. Device Mame Settings Device
1 [P [ [Mirirmum Frame=0FF mas word Block Fiead=64 o
Setup Items Setup Description
SIO Type Select the SIO type to communicate with the External Device.
Speed Select speed between the External Device and the Display.

Data Length

Select data length.

Parity Select how to check parity.
Stop Bit Select stop bit length.
Select the communication control method to prevent overflow of transmission and
Flow Control .
reception data.
) Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the
Timeout .
response from the External Device.
Retr In case of no response from the External Device, use an integer from 0 to 255 to enter how
y many times the Display retransmits the command.
Wait To Send Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving

packets to transmitting next commands.

GP-Pro EX Device/PLC Connection Manual
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Setup Items Setup Description
You can toggle between RI and VCC on the 9th pin when the SIO type is RS232C.
RI/VCC When you connect to the IPC, to toggle between RI and 5V, use the IPC's changeover
switch. Please refer to the manual of the IPC for more details.

NOTE * Refer to the GP-Pro EX Reference Manual for Indirect Device.
Cf. GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect

Device)"

W Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]

window, select the external device and click [Settings] [ .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

## Individual Device Settines [E3

PLC1

™ Minimurn Frame

oK@ | cancel |

Setup Items Setup Description

Select the Minimum Frame check box to minimize the length of device addresses in
communication frames.

Minimum Frame
For example, M0009 is converted to M9.

GP-Pro EX Device/PLC Connection Manual 12



PMAC Controller SIO

4.2 Setup Items in Offline Mode

* Please refer to Maintenance/Troubleshooting Guide for more information on how to enter

offline mode or about operation.
Cf. Maintenance/Troubleshooting Guide "Offline Mode"

* The number of the setup items to be displayed for 1 page in the offline mode depends on the

Display in use. Please refer to the Reference manual for details.

B Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch the

External Device you want to set from the displayed list.

| Cormm, Device Option

PMAC Controller SI0 [COMT] Page 1/1
SI0 Type R52320 =
Speed 38400 i
Data Length L ° §
Parity « NONE © EVEN © DD
Stop Bit e ] LB
Flow Control J NONE > |
Timeout(s) Jlw|a
Retry 7 w|a
Wait To Send{ms) iw| a
; 2013/05/186
| Enit | . 17:01:44
Setup Items Setup Description
Select the SIO type to communicate with the External Device.
IMPORTANT
To make the communication settings correctly, confirm the serial interface specifications of
SIO Type Display unit for [SIO Type].
We cannot guarantee the operation if a communication type that the serial interface does not
support is specified.
For details concerning the serial interface specifications, refer to the manual for Display
unit.
Speed Select speed between the External Device and the Display.

Data Length

Select data length.

Parity Select how to check parity.
Stop Bit Select stop bit length.
Select the communication control method to prevent overflow of transmission and reception
Flow Control
data.
Timeout (s) Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the

response from the External Device.

GP-Pro EX Device/PLC Connection Manual 13
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]

Setup Items Setup Description

In case of no response from the External Device, use an integer from 0 to 255 to enter how

Retry many times the Display retransmits the command.

Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving

Wait To Send (ms) packets to transmitting next commands.

W Device Setting
To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings]. Touch the

External Device you want to set from the displayed list, and touch [Device].

Setup ltems Setup Description

Select the External Device to set. The device name is set up in GP-Pro EX. (Initial value

Device/PLC name [PLC1])

Set [Min. Frame] to [Enable] to minimize the length of device addresses in communication

. frames.
Min. Frame

For example, M0009 is converted to M9.

GP-Pro EX Device/PLC Connection Manual 14
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W Option
To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device
you want to set from the displayed list, and touch [Option].

Setup Items Setup Description

You can toggle between RI and VCC on the 9th pin.
RI/VCC When you connect to the IPC, to toggle between RI and 5V, use the IPC's changeover
switch. Please refer to the manual of the IPC for more details.

NOTE * GP-4100 series, GP-4*01TM and GP-Rear Module do not have the [Option] setting in the
offline mode.

GP-Pro EX Device/PLC Connection Manual 15
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5 Cable Diagram

The cable diagram shown below may be different from the cable diagram recommended by Delta-TAU data

system, inc. Please be assured there is no operational problem in applying the cable diagram shown in this

manual.

* The FG pin of the External Device body must be D-class grounded. Please refer to the manual of the External
Device for more details.

* SG and FG are connected inside the Display. When connecting SG to the External Device, design the system
not to form short-circuit loop.

*  Connect the isolation unit, when communication is not stabilized under the influence of a noise etc.

Cable Diagram 1

Display
(Connection Port)

GP3000 (COM1)
GP4000"! (COM1)
SP5000"% (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC"3

PC/AT

GP-4105 (COM1)
GP-4115T (COM1) 1B User-created cable Cable length: 15m or less
GP-4115T3 (COM1)

*1  All GP4000 models except GP-4100 Series and GP-4203T
*2  Except SP-5B00

Cable Notes

1A User-created cable Cable length: 15m or less

*3 Ol%the COM port which can communicate by RS-232C can be used.
"® [PC COM Port" (page 4)

GP-Pro EX Device/PLC Connection Manual 16
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|

1A)
Display External Device
D-Sub 9 pin (socket) 10 pin header
Pin | Signal name Pin | Signal name
1 CD ,-S-'r-’i-e-';fj.‘ 1 DCD
2 RD(RXD) |—t- / i 3 TXD
Display 3 SD(TXD) 5 RXD
4 ER(DTR) — 7 DSR
5 SG . 9 GND
6 DR(DSR) |+— 2 DTR
7| RSRTS) fe—i—i— 4 cTs
8 | cscrs) LR S SN RTS
Shell FG “eeohd——T Shel FG
1B)
Display External Device
Terminal Block 10 pin header
Signal name . Pin | Signal name
CD Shed 1 DCD
RD(RXD) PR 3 XD
Display SD(TXD) |—i——— 5 RXD
ER(DTR) —t b 7 DSR
SG R S 9 GND
DR(DSR) |+— 2 DTR
RSRTS) Je—t—t— 4 CcTS
CS(CTS) ML S SN RTS
Moo Shel FG

GP-Pro EX Device/PLC Connection Manual 17
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6 Supported Devices

The following section shows the range of supported device addresses. Please note that the actual supported range
of the devices vary depending on the External Device to be used. Please check the actual range in the manual of
your External Device.

This address can be specified as system data area.

Device Bit Address Word Address 32bits Notes

I-Device - 10000 - 18191 e

P-Device - P0000 - P8191 Rl
: H! L| 5

Q-Device - Q0000 - Q8191 Ei t31|

M-Device ; M0000 - MSI91 | T e

*1 1, P,Qand M are 48 bit real devices on the External Device. You can also use hexadecimal and decimal values
with these devices. However, the Display handles these device addresses as 32-bit devices.

NOTE * Please refer to the GP-Pro EX Reference Manual for system data area.
Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
* Please refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"

GP-Pro EX Device/PLC Connection Manual 18
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PMAC Controller SIO

Use device code and address code when you select "Device Type & Address" for the address type in data displays.

Device Device Name Device Code (HEX) Address Code
I-Device I 0001 Double Word Address
P-Device P 0002 Double Word Address
Q-Device Q 0003 Double Word Address
M-Device M 0000 Double Word Address
Special Device SP 0060 Double Word Address*! 2

*1 Read disable

*2  Input device for online commands. You can send commands to the PMAC Controller via the SP device
without a PMAC Executive Pro Suite (Pewin32 Pro) terminal. When a PMAC controller receives
alphanumeric text over the serial port, the PMAC controller interprets the set of alphanumeric characters
as a command and executes the command immediately.

GP-Pro EX Device/PLC Connection Manual 19
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8 Error Messages

Error messages are displayed on the screen of Display as follows: "No.: Device Name: Error Message (Error

Occurrence Area)". Each description is shown below.

ltem

Description

No.

Error No.

Device Name

Name of External Device where error occurs. Device name is a title of External Device set
with GP-Pro EX. (Initial value [PLC1])

Error Message

Displays messages related to the error which occurs.

Error Occurrence Area

Displays IP address or device address of External Device where error occurs, or error codes
received from External Device.

» IP address is displayed such as "IP address (Decimal): MAC address (Hex)".
* Device address is displayed such as "Address: Device address".
» Received error codes are displayed such as "Decimal [Hex]".

Display Examples of Error Messages
"RHAAOQ035:PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

NOTE » Refer to your External Device manual for details on received error codes.
+ Refer to "Display-related errors" in "Maintenance/Troubleshooting Guide" for details on the

error messages common to the driver.

GP-Pro EX Device/PLC Connection Manual 20
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